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Disclaimer: these short course notes are not a substitute for complete software manuals and training
courses. They do not cover all configurations and processing tasks.

1. MagMap Data pre-processing.
Main goal: Prepare XYZ file for further processing.
Steps:


Load magnetometer BIN file.



Edit local position grid as necessary.



View magnetic field.



Export XYZ file without base station.



Load Base Station BIN file.



View and smooth base station readings.



Export XYZ file with base station correction.



Position data using embedded GPS.



Position data using measured corners coordinates.



Offset magnetometer relative to GPS.



Export Latitude / Longitude data.
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Loading binary (BIN) file:

Select File / Open menu and then pick BIN as file type and select your file:

You will see a picture similar to this:
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The large green rectangle shows the start of the line, the red rectangles indicates the end of the line and
blue smaller rectangles show “marks” along the line. This is your survey plan in the LOCAL
coordinate system (X- Y) WITHOUT GPS.
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Right click the mouse to call a context sensitive menu. Depending on where you click, you will see
different menus. When you click on the green or red start/stop marks the menu for the whole line is
shown. You can see position operations (such as shift and rotate), you can plot magnetic field for this
particular line or you can delete the line.
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When you click on a blue rectangle you can modify the particular position you selected. This is shown
in above screen shot.
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As an example, “Shift by” is selected. You can enter a position shift you want to shift line by a certain
amount in the X or Y direction. In this example we entered 2.5 m to the right. The units are the same as
the local coordinate system units, meters in most cases.
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The result of the shift is shown above. You can see that line has been shifted from X=20 to coordinate
X=22.5.
Because this is just an example, we want to return this line to its previous position. The “Undo”
operation is available from “Edit / Undo” menu. There is only one undo level, so the operation has to
be reversed in the next process.
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Here the line is returned to its original position. The context menu shows “Plot Mag Field” to plot
magnetic field as function of time. We recommend this quick review of the data always be performed
early in the data analysis.
Place the mouse cursor on one of the large red or green squares and right click. Choose “Plot Mag
Field” from the popup menu to display a magnetic field plot for that line.
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Note the difference: if you right click in between the lines, somewhere on the green field, the program
will plot ALL data in the survey as one profile graph:
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While the profile plot is shown you have access to filtering processes from the menu bar which include
removal of dropouts or Range Despike. More information is available in the MagMap2000 manual. If
you right click on the graph view, you can select additional options from context menu, such as which
sensor channels to plot, graph vertical limits, etc. Here the sensor channel selection dialog is shown:

Note that we selected only “Sensor 1”, which is plotted with red color. After “Ok” is pressed, the
program updates the picture:
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We see only the red channel as shown.
The magnetic field can now be exported as an XYZ text file. This file can be used by third party
software or MagPick to prepare magnetic field maps and estimate positions of the magnetic bodies.
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Right click on the map and select “Export”. Alternatively, use the “File” menu.
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The Export dialog box is shown above. Note the blinking text in the bottom left corner which states:
NO VALID BASE STATION FILES ARE CURRENTLY OPEN!!! This indicates that no magnetic
base station was loaded, and no diurnal correction is going to be done during export.
After the export is complete you can check it with a text editor. Below is a screen shot of a typical
exported format for MagMap XYZ file. This is for a two sensor (858) device.
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We will now return to an earlier step and load a base station data. In this particular example we have
data from a G-858 magnetometer run in base station mode, but it could be data from variety of devices
including the G-856AX or G-823B. Use “File / Open” menu:

An additional window appears on the screen:
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This is the base station window which shows the base station readings as a function of time. DO NOT
CLOSE THIS WINDOW until the export process is complete.
In some cases the base station could have noisy data. We can smooth it using Filter / Smooth base
station readings facility in the Filter menu:
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Here the smoothing dialog is shown:

Select the smoothing degree (increase the value for more smoothing) and press “Preview” button. The
program shows a preview with a black line as shown below:
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To accept result of the smoothing pull up the same Filter-Smooth menu and press “Accept”:

You can see now that the black line is gone and a red line with a smoother appearance has replaced it.
We are now done with the base station data and can re-export the diurnally corrected survey data by
right clicking on the position map and using “Export”.
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Note that there will now be no warning about a missing base station file in this dialog box and also
additionally fields as “LEFT DIURNAL” and “RIGHT DIURNAL” are available. Below is the result
of the export process and how it appears in the text editor:

You can see two additional columns LEFT_DNL and RIGHT_DNL. They contain the base station
corrected magnetic field. The base correction has been applied in the following mathematical
subtraction: sensor reading – base station reading. Therefore the numbers in the dnl columns will be
very close to zero value and the variations will be shown as plus and minus values.
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The next step explains how to use GPS data that is contained in the bin file. There are two modes
possible: GPS recorded with magnetometer readings and GPS used to measure corners of the area.
Assuming GPS was recorded in the 858 console with the magnetometer data, two options are possible:

These are “Draw new map using GPS data and feature of regular 858 survey” and “Draw new map
using GPS data and features of MagLog NT survey” The first case is much the same as for the local
coordinate grid. The second option has additional features such as sensor repositioning. In both cases
data is reloaded from the BIN file, so editing/filtering (if any) must be reapplied after calling this GPS
menu. (The local coordinate X-Y grid window can be closed after GPS window is opened.) The picture
above shows the view after the GPS data is loaded. Note that the map is displayed in latitude and
longitude in decimal degrees and that the scales along the X and Y axis are different.
The aspect ratio can be adjusted to true coordinate relationship by selecting this button:
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Now the aspect ratio is shown in its true relationship. You may wish to return to “best view” mode by
re-clicking on the “True Coordinate” button. Incorrect or clearly out of place GPS positions can be
deleted and the positions reinterpolated between known good GPS fixes. The overall GPS track can be
smoothed using MagMap2000 (GPS, Smooth Track). See complete manual for details.
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Another way to bring GPS data is to use known fixes such as the four corners of the area. For each of
the points the local coordinates in latitude and longitude should be provided by the user. For instance,
a geodetic grade GPS could be used to measure all four corners of the area.

The function is available from “Survey setup / Local system transformation” menu as shown above.
The following dialog is displayed:
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Initially the dialog is blank. The user adds coordinate points using the “Add...” button as shown below:

Note that all four values must be filled in. After at least four points are entered the dialog is ready for
transformation. If the transformation procedure uses Latitude/Longitude as a new system check the
“New coordinates are Longitude and Latitude” box.
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The result of the transform is shown below:

Note that compared to the recorded GPS there is no random noise in the positions . This is because
each data point has been re-mapped to the transform surface.
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The data now can be re-exported with geographical (GPS Lat/Long) positions. The snapshot below
shows the content of the file:

Note that “X” and “Y” are in decimal degrees as shown.
We now discuss the second GPS mode, Draw new map using GPS data and features of MagLog NT
survey” which is used to offset the position of the magnetometer sensor(s) relative to the GPS antenna.
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In this case MagMap opens two windows: a GPS position window and a magnetometer data window.
DO NOT CLOSE EITHER OF THESE WINDOWS in the following procedures. In the data window the
magnetometer data is plotted as a function of time. In the GPS window the GPS positions are plotted.

To offset magnetometer sensor positions relative to GPS antenna, use the “GPS” and “GPS offset”
menu:
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The GPS Offset Setup dialog on the left shows the coordinate system used to offset the magnetometer
sensor relative to the GPS antenna position. To enter the offsets press the “Multiple offsets setup”
button and the dialog on the right will be displayed. Enter offsets in meters according to the directional
instructions on the left, add the name of the point and press “Add”. For land surveys select “Do not use
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dragging”.
It is important to understand that the offset calculation takes place during export and not
directly after the dialog is closed. To see the effect of the new offsets, first invoke the export
function:
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Select the data you want to export and press the “Export Now” button to export the data in a *.dat file.
Re-import the file using “Surfer *.dat” import file name selection. See the complete manual for more
information
Highlights of part 1:


MagMap2000 works like a filter: takes in the BIN file and produces an ASCII XYZ file
with magnetometer positions and field readings.



There is no option to save the intermediate results. The XYZ file must be created
(exported) before MagMap is closed, or or the changes will not be saved.



MagMap can modify the initial positions and data.



Base station diurnal correction and re-positioning takes place ONLY during export.
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12. Data processing with MagPick.
Main Goal: Prepare a map with MagPick and Export it as a Google Earth *kmz file.
Steps:


After processing with MagMap2000, load profile XYZ data (local coordinates) into MagPick.



Make a profile map and profile views.



See how the profile graph aligns with the map.



Make a stack plot in MagPick.



Interpolate a map in MagPick (grid and contour the data).



Save the project.



Load the XYZ profile data with GPS coordinates and repeat the steps above.



Export the map in Google Earth *.kmz format.

32

To load profile XYZ data into MagPick, use the “Simple load” menu:

The loading dialog is displayed as the following:

Press the “Add” button to select an existing file, possibly with the extension “.DAT”. Note that you
could select multiple files at one time, assuming they all have the same format. In this way you can
load data from several adjoining surveys into one project.
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Set the data fields in shown in the dialog below:
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Note that “No UTM” is selected (when data is in X-Y coordinate system) and only one data channel is
loaded. “Depth” is selected as “Fixed” and is set to -0.9 m. This is the typical magnetometer height
above the ground for UXO surveys. Press “Ok”.
Now one file is added to the loading list:
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You can add multiple files by pressing “Add” button again. To add another channel (such as the right
sensor) press “Add channel” (not covered in this presentation). To save the list of channels or files give
the List File a name. Press “Ok” to load the data. After the load is complete, a dialog box is displayed
(for this particular example, 10 lines of data):

Press Ok to close the dialog. Now go to “File / New” menu:

And select “Grid view” in the “Create” dialog:

You may see the window similar to one below:
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This is the map of the profiles. The red profile is the “Active” profile to be displayed in the profile
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window. To see this profile go to “File / New” and select “Profile view”

The result may look like this:
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On the grid view (left) “right click” to select context menu and select “Pick profile” mode:

Now you can see another profile in the window and the red profile line on the grid map:
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To change the profile view parameters, right click on the graph to call up the context menu:

Click on Settings to invoke the profile view parameters dialog:
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Note that you can change size of the canvas in pixels and definition (along X or along Y) of the
horizontal axis. Profile data can be plotted along X, Y, or distance along the profile, as well as a
function of time.
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You can modify the size of the map view using Options / Size menu (call this menu from the grid
window):

Click “Keep cells squared” then slide the X Cell size to “4” or “5” and click “Ok” to see the size effect
this has. This will update the map view. To add additional information on the map, go to “Options /
settings” menu:
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And put grid lines on the map by selecting appropriate grid intervals:

You can also add stack profile information on the map by clicking the “Show profiles*” dialog. Note:
In MagPick you need to first un-check then re-check the box to call the profile dialog as shown below:
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Now grid window can look like:
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Change the “Data Scale” value to make the green stack plot values the appropriate size for your profile
plot. You can save window contents as a TIFF file by going to “File / Picture Export / Geotiff”
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The GeoTiff properties dialog box is displayed (please consult MagPick manual for other options)

Press “Ok”, and select a file name and save the file. This file can be included into MS Word text
documents.
The next step is to interpolate the map. This means that profile data is going to be interpolated on a
regular grid. From the grid window, call:
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The Grid Interpolation dialog is displayed:

The most important parameters are “Interval” and “Output file”. The interval should be selected based
on measured data spacing. For G-858 this could be based on line spacing or a combination of line
spacing and sample spacing (between 0.2 and 1m). The number of iterations should be approximately
2000. Give the output file a new file name, typically with extension “nc”. (We recommend the
“NetCDF” format.) Please consult the MagPick manual for the meaning of other parameters.
47

Grid interpolation could take a considerable amount of time depending on the PC processor power and
memory (typically a minute or less). The progress dialog will be displayed:

After interpolation is complete, a map will appear as shown below. Note that you can change the color
scale and color pallet by unclicking and reclicking the Colored Map button on the Common Parameters
dialog :

See that the profiles are still displayed on top of the map. You can remove them from map (but not
from the memory) by calling the “Options / Setting” dialog box.
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Now save the MagPick workspace into a “project file” for future use. Go to File, Projects, Save As:

Select project file name (extension “magpick” and press “Ok”). The Project can be quickly loaded into
MagPick and all previous work reloaded.
In the last part of this presentation we show how to load data with GPS positions (latitude and
longitude).
Go to “File / Projects / Close Project” and start over with simple load:
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Follow the same path until you get to the “Create profile description” dialog:

IMPORTANT: to load GPS positions, you need to select UTM projection. The easiest way to do this is
to just select “Auto UTM” in the “Apply UTM on input” dialog box. The UTM setup dialog will pop
up to allow you to adjust projection parameters:
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In most cases just press “Ok” to accept the parameters and close the dialog.
It is important to understand that to process GPS data MagPick must apply a cartographic projection
and operate in meters. The Projection used in MagPick is the Universe Transverse Mercator (UTM)
widely accepted for topographic maps. In addition MagPick uses False Northing and False Easting
values to reduce the size of the UTM projection numbers which otherwise are very big and can cause
inaccuracies. Thus False Nothing and False Easting settings must be used.
Process the data in the same way as described above to create a grid window. The grid window will
now look like this:
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Note the coordinate annotations are in meters on the grid. These are short UTM Northing and Easting
values. When exporting the data, the original Latitude and Longitude values can be reinstated. See
MagPick manual for complete instructions.
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MagPick maps can be exported into variety of formats, including PostScript / PDF, DXF, GeoTIFF and
Google Earth KMZ file. Here we show how to export into Google Earth format.
From the File menu, select “Export / Google Earth”:

The following dialog is shown on the screen:

You can modify the appearance of different layers exported into the Google Earth. Select the layer you
wish to modify and press “Properties” or double click on it. Note that it is also possible to change the
transparency after the picture is loaded into Google Earth.
“Apply inverse UTM” should be checked.
Save the file in a location to which you can easily navigate. Press the “…” button and navigate to the
folder where you want to save results, then type a file name.
If Google Earth is installed and the checkbox “Start Google Earth after file is saved” is checked then
Google Earth will start automatically and show the geographical location of the area, similar to the
screen shot below:
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The user can modify the appearance of the map using the Google Earth slider control in the left pane of
the program.
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23. UXO location estimation (inversion) with MagPick.
Main Goal: Show how to locate positions of magnetic bodies with MagPick.
Steps:


Load magnetic field data set for 500 lb UK bomb target from WWII.



Make a grid and profile view.



Show how “manual targets” are used in MagPick.



Select data for inversion using a polygon.



Compute inversion.



Show results in a spreadsheet.



Export results into Excel.

Start with “Simple Load” as explained in the previous sections and navigate to the file
bomb_diurnal.dat supplied on the Magnetometer CD. Then fill in profile description dialog as shown
below:

55

Note that depth and altitude are fixed. This means that the depth will be estimated from the sensor level
(not burial depth). Press “Ok” in the profile load dialog:

The program will report the number of profiles loaded:

Now create a “grid view” by calling “File / New” menu and selecting grid view below:
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The grid view may look like the picture below. You may need to adjust size and appearance using
“Options /Size...” and “Options / Settings” menus.

The next step is to create a profile view. Go to menu “File / New” and create “profile view”. After this
your screen may look like the picture below (adjust window placement manually; also adjust profile
view parameters as explained in previous sections). Select the profile to be X=8 on the grid using
“Select profile” from the context menu as explained in the previous section of this presentation.
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The red line on the map represents the field displayed in the profile view window. Before we go to the
inversion procedure we will demonstrate the “Manual target” picking function in MagPick. Right click
on the profile view and select “Set marker”
Now move the mouse to locations on the profile view with horizontal axis value 4 (click) and 16
(click). You must click on the red line to set a marker. After you complete this procedure the picture
will look like this:
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Note two markers:

and

on the profile view and map view.

The next step is to compute middle point between these two markers. That middle point will be an
approximate location of where magnetic body might be located. From the profile view, go to menu
“Edit / Pick profile target (Ctrl-Z).” Note that you also could use keyboard short cut “Crtl-Z”
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The profile view will show your target:

The dashed line here is just to show you that you selected a manual target. It coincides with the
observed field. Do not confuse it with model field (see below). You can also see this location on the
grid view:
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Note that it is located precisely on the profile. To see digital information regarding the target analysis,
go to menu “Inverse / Work sheet / Targets”:

This will create work sheet view as below:

Note that this is the “Manual targets” sheet, which means that the X and Y were set by hand, and Z
(sensor to target distance) may be incorrect (in fact Z is computed to be just half the distance between
the marks you used to set this manual target). There are other ways to set manual targets in MagPick.
See MagPick manual for details.
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Now we present the inversion process which is based on the profile data. The goal is to find a model
which could explain the observed anomaly. MagPick uses the simplest possible model – a dipole. This
is an equivalent to a uniformly magnetized sphere. Most of the objects we encounter can be treated as
dipoles if the distance from the object is 3 times or more than its linear size. For instance, an artillery
shell of 50 cm length could be considered dipole at distances 1.5 m or more. It cannot be considered a
dipole at a distance of 0.5 m, and in this case MagPick inversion is not applicable.
To start the inversion we need to find the Earth magnetic field declination (D) and inclination (I) in
your area. The picture below explains the meaning of these angles but in essence D is the difference
betten geographic north and magnetic north and I is the dip angle of the earth’s field at your location:

In order to find the value of “D” (declination), start from the profile view and go to the Inverse / IGRF
model.

The IGRF stands from International Geomagnetic Reference Field. This is a global model, which
allows us to compute the I (inclination) and D (declination) on every point of the Earth.
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The IGRF dialog is displayed:

Here you need to enter year when data was collected (1997 in this example) and the approximate
coordinates (9E, 53N, Germany) and press “Calculate” to update I and D. Then check “Accept
parameters for inversion” to use them later in this procedure.
The next step is to restrict data we are going for use by the inversion. In this example we are going to
use a polygon to circumscribe the area. Right click on the grid view and select “Add / Add polygon”
from the context menu.
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Then draw polygon shape around the manual target. To close the polygon, double click.

Here the polygon is shown on the map (your polygon could be transparent).
Make sure the polygon has the property to restrict (clip) the data. With the polygon selected, right click
on it to call the polygon context menu as shown here:
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Select “Edit” to show polygon properties dialog:

Make sure “Use polygon to clip data” is checked and press Ok.
Now everything is ready to start the inversion. Go to profile view and select “Inverse / Run”
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The inversion dialog will be displayed:

Make sure your dialog parameters match the screen shot above. Note that values of inclination and
declination are copied from the IGRF dialog box. Ensure the “Extended area” is set to “Polygon” for
this example.
The initial source depth is also important. To converge to an acceptable solution the program needs to
start with realistic initial estimate of the target depth. In this case a depth of 2m to 5 m is realistic, while
depth of 20 m is not.
Press the “Ok” button and the program starts the inversion iteration process showing a progress dialog.
After the inversion is complete both a profile view and a map view will result:
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In the profile view a model of the field is shown with dashed line. It should closely match the observed
field (plotted with solid line). The closer these two lines are to each other, the better.
A target position will be shown on grid map and is annotated with an X or cross. Note that the position
of the target is not on a survey line because the inversion process has taken data from multiple lines and
made the best dipole fit to the position of the target, in this case in between two lines.
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You can also check the field results on close parallel lines. On the left line from center:

And on the right line from center (note that these plots have different vertical scale):

To view the digital values of the location estimate bring up the dipole worksheet:
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Which will appear as follows:

The meaning of the main values in the spreadsheet is the following:
1. X – x-coordinate of the estimated location
2. Y – y-coordinate of the estimated location.
3. Z – depth, positive down. In this example it is distance from the sensor.
4. Fit – average difference between observed (solid) and computed (dashed) magnetic fields. The
smaller values are better.
5. Mass1 – estimated mass. This estimation is based on average susceptibility magnetic properties
of steel and may not be accurate. It may vary by an order of magnitude (say 20 and 200).
6. M2/Angle – Angle between dipole magnetization vector and Earth's magnetic field.
7. Discr, %. Relative quality (confidence, fidelity) of the modeling. Acceptable values are above
80%.
The last step of this procedure is to export the results into a spreadsheet. Right click on the “Dipole
sheet” window and select “Export”:
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This calls up the file selection dialog box. Select CSV (comma separated values) default format.

After you press “Save” the program will call the default spreadsheet application (Excel or Open Office
Calc) and loads this file automatically:
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3 Overall review.
The following was covered:
 Field data pre-processing with MagMap. The main output of that stage is creation of the XYZ
file.
 Map preparation with MagPick. The main output is a professional magnetic map of the area.
 Magnetic inversion to estimate positions of the targets with MagPick. The main output is a
spreadsheet with the estimated location and depth of the targets.
This ends these review notes.
For additional information please contact sales@geometrics.com or support@geometrics.com
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